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1. UHPC System Introduction 
 

NOVONIX’s Ultra High Precision Coulometry (UHPC) battery testing systems offer industry leading 
accuracy and precision for battery test electronics.  Each channel can operate in constant current 
or constant voltage charge and discharge modes across the full 0 – 5 V load window.  Systems 
typically come with integrated thermal chambers to ensure the temperature stability of the cell to 
minimize noise, and eliminate temperature variations, in collected data. In addition to the thermal 
chamber temperature monitoring, each channel connected to a cell holder and RTD constantly 
monitors local cell temperature and reports it to the UHPC Control software.  When used under 
appropriate conditions, each channel can measure coulombic efficiency to better than 20 ppm 
precision and better than 50 ppm accuracy. 

The software allows users to easily build test protocols to start experiments and monitor the status 
of each channel.  Data analysis software outputs data in various formats for ease of analysis and 
understanding of cell performance. 

The system is to be used as delivered, not modified or controlled by external software.  The unit is 
used for testing electrochemical cells within the known limits between 0-5 volts in different 
operation modes (constant current charge/discharge, constant voltage charge/discharge or open 
circuit storage).  This includes devices like rechargeable batteries (all chemistries) and 
supercapacitors. 
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2. Definitions 
 

Filename 
abbreviation 

Symbol Description Units 

- VL Lower voltage limit for standard cell cycling (Fig 1) V 

- VU Upper voltage limit for standard cell cycling (Fig 1) V 

Qc QC Charge capacity for the cell (charged from VL to VU) (Fig 1) Ah 

Qd QD 
Discharge capacity for the cell (discharged from VU to VL) 
(abs. value) (Fig 1) 

Ah 

CE CE Coulombic efficiency: 𝑪𝑬 =  
𝑸𝑫(𝒏)

𝑸𝑪(𝒏)
  unitless 

CIE CIE Coulombic inefficiency: 𝑪𝑰𝑬 =  𝟏 − 𝑪𝑬 unitless 

CIEhr CIE/hr Coulombic inefficiency per hour: 𝑪𝑰𝑬/𝒉𝒓 =
(𝟏−𝑪𝑬)

𝒄𝒚𝒄𝒍𝒆 𝒕𝒊𝒎𝒆
 hour-1 

CendPt EPC 
Charge endpoint capacity: 𝑬𝑷𝑪(𝒏) =  𝑬𝑷𝑫 (𝒏 − 𝟏) +
 𝑸𝑪(𝒏) 

Ah 

DendPt EPD Discharge endpoint capacity: 𝑬𝑷𝑫 (𝒏) =  𝑬𝑷𝑪 (𝒏) + 𝑸𝑫(𝒏) Ah 

SlipC ∆C Charge slippage: ∆𝑪 (𝒏) =  𝑬𝑷𝑪 (𝒏) – 𝑬𝑷𝑪 (𝒏 − 𝟏) (Fig 2) Ah 

SlipD ∆D Discharge slippage: ∆𝑫 (𝒏) =  𝑬𝑷𝑫 (𝒏) – 𝑬𝑷𝑫 (𝒏 − 𝟏) Ah 

SlipCpercent ∆C% Charge slippage percent: ∆𝑪% =  ∆𝑪 (𝒏)/𝑸𝑪(𝒏) ∗ 𝟏𝟎𝟎 % 

SlipDpercent ∆D% Discharge slippage percent:  ∆𝑫% = ∆𝑫(𝒏)/𝑸𝑫(𝒏) ∗ 𝟏𝟎𝟎 % 

Fade Fade Capacity fade: 𝑭𝒂𝒅𝒆 =  ∆𝑪  −  ∆𝑫 Ah 

ZeroedCendPt EPC
0 Zeroed charge endpoint capacity: 𝑬𝑷𝑪

𝟎  =  𝑬𝑷𝑪-
 (𝒏) – 𝑬𝑷𝑪 (𝒏 = 𝒓𝒆𝒇) 

Ah 

ZeroedDendPt EPD
0 Zeroed discharge endpoint capacity: 𝑬𝑷𝑫

𝟎  =  𝑬𝑷𝑫-
 (𝒏) – 𝑬𝑷𝑫 (𝒏 = 𝒓𝒆𝒇) 

Ah 

Qcpercent QC% 
Capacity charge percent: 𝑸𝑪% =  𝑸𝑪(𝒏)/𝑸𝑪(𝒏 =  𝒓𝒆𝒇) ∗
𝟏𝟎𝟎 

% 

Qdpercent QD% 
Capacity discharge percent: 𝑸𝑫% =  𝑸𝑫(𝒏)/𝑸𝑫(𝒏 =
 𝒓𝒆𝒇) ∗ 𝟏𝟎𝟎 

% 

CendPtPercent EPC % 
Charge endpoint capacity percent: 𝑬𝑷𝑪 % =  𝑬𝑷𝑪-
 (𝒏)/ 𝑬𝑷𝑪 (𝒏 =  𝒓𝒆𝒇) ∗ 𝟏𝟎𝟎 

% 

DendPtPercent EPD % 
Discharge endpoint capacity percent: 𝑬𝑷𝑫 % =  𝑬𝑷𝑫-
 (𝒏)/ 𝑬𝑷𝑫 (𝒏 =  𝒓𝒆𝒇) ∗ 𝟏𝟎𝟎 

% 

AvgVc VavgC Average charge voltage: 𝑽𝒂𝒗𝒈𝑪 =  ∫ 𝑽𝒅𝑸
𝑸𝒄

𝟎
 V 

AvgVd VavgD Average discharge voltage: 𝑽𝒂𝒗𝒈𝑫 =  ∫ 𝑽𝒅𝑸
𝑸𝒅

𝟎
 V 

DeltaV ∆V ∆𝑽 =  𝑽𝒂𝒗𝒈𝑪 − 𝑽𝒂𝒗𝒈𝑫  V 

dVdQ dV/dQ Differential capacity 
𝒅𝑽

𝒅𝑸
(𝒏) =  

𝑽(𝒏)−𝑽(𝒏−𝟏)

𝑸(𝒏)−𝑸(𝒏−𝟏)
 VAh-1 

dQdV dQ/dV Differential voltage 
𝒅𝑸

𝒅𝑽
(𝒏) =  

𝑸(𝒏)−𝑸(𝒏−𝟏)

𝑽(𝒏)−𝑽(𝒏−𝟏)
 AhV-1 

Vdrop ∆Vst 

Voltage drop during storage – the change in voltage from 
when a cell starts open circuit storage to the time the cell 
starts charging or discharging again 

V 
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Ec EC Charge energy: 𝑬 𝑪 =  𝑸𝑪  ∗  𝑽𝒂𝒗𝒈𝑪 Wh 

Ed ED Discharge energy: 𝑬𝑫  =  𝑸𝑫  ∗  𝑽𝒂𝒗𝒈𝑫 Wh 

EE EE Energy efficiency: 𝑬𝑬 =  𝑬𝑫(𝒏) / 𝑬𝑪(𝒏)  unitless 

Ecpercent EC% Energy charge percent: 𝑬𝑪% =  𝑬𝑪(𝒏)/𝑬𝑪(𝒏 = 𝒓𝒆𝒇) ∗ 𝟏𝟎𝟎 % 

Edpercent ED% 
Energy discharge percent: 𝑬𝑫% =  𝑬𝑫(𝒏)/𝑬𝑫(𝒏 = 𝒓𝒆𝒇) ∗
𝟏𝟎𝟎 

% 

Figure: An example of a voltage versus run time plot displaying the parameters lower voltage limit (VL), upper 
voltage limit (VU), charge capacity (QC), discharge capacity (QD) and cycle time. 

 

Figure: An example voltage versus capacity curve with an inset showing the charge slippage (ΔC). 
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3. System Safety Overview 
UHPC systems comprise of various software applications, channel modules, thermal chambers, 
control module and PC. Safety is designed into the system and outlined below. 

3.1 Standard Monitoring 

Standard monitoring continuously runs on all systems, to ensure that unexpected conditions do not 
persist. Standard monitoring tracks:  

 
• Occurrence of bad values  
• Current set point stability  
• Voltage set point stability 
• Inactive channels 
• System connections  

o Between PC and control module 
o Between control module and channel module 
o Between each channel and control module  

 

Should any anomalies be recognized by standard monitoring, the system will isolate offending 
channels, thereby breaking the physical current connection. Further, the current set point is 
reduced to near zero as a secondary precaution. 

3.2 Safety Limits 

Safety Limits are the UHPC Control’s system emergency test safety measures. When breached, the 
system will begin test shutdown. This specific behavior can be modified in  Startup Configuration to 
either stop all tests, suspend the impacted test, or by default: Stop the impacted test. Safety Limits 
can have three levels. In order of hierarchy, they are: 
 

1. System Limits – System Limits are set before shipment and cannot be changed. These can 
only be viewed in UHPC Control. The system limits are the top hierarchy, and all types of 
limits must be within the range of system limits. 

2. Global Limits – Global limits are shared between UHPC Protocol and UHPC Control, they 
require an admin password to edit. The Global Limits must be within the System Limits. 
These limits are enforced on all protocols loaded/running in UHPC Control. When Global 
limits are breached, the test will generally stop, although it can be configured to suspend the 
channels instead. 

3. Step Limits – Step Limits are fully customizable by the user, without requiring any admin 
password. They can be set in UHPC Protocol. Step limits should be within Global Limits and 
are identical to global limits by default. You can set custom limits, so that your tests stop or 
suspend if a certain threshold was breached during testing. The intent of Step Limits is for 
the user to be able to configure more constrained step specific (or test specific) limits 
without impacting every test executing on UHPC Control. 
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For the Global and Step Safety Limits, an Operating Limit can be set for: 

 
Channel Current (A), Cell Voltage (V), and Cell Temperature (C) 

Should the Operating Limit be met or exceeded, then the non-compliant channel will be isolated and 
have Channel Current set-point set to near zero. If the user has configured the system to shut down 
all channels on reached limit, then all channels will be isolated and have Channel Current set-point 
set to zero. Any changes to the thresholds must be made with appropriate user permission.  

 

Limits are set to the following values, before shipment: 
 

 
System Limits  

Global 
Limits 

Step limits 

 Min Max Min Max Min Max 
Channel Current (A) – 2 Amp 0 2.2 0 2.05 0 2.05 
Channel Current (A) – 10 Amp 0 10.2 0 10.05 0 10.05 
Channel Current (A) – 20 Amp 0 20.2 0 20.05 0 20.05 
Cell Voltage (V) 0 5.2 0 5 0 5 
Cell Temperature (°C) -150 500 -50 80 -50 80 

 
 

For further information and support, please contact us. 
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4. Software Download and Installation 

4.1 Software Download 

Three software programs are supplied with a system. Software and user manual can be found in 
NOVONIX Customer Area. Please contact us if further information is needed.  

UHPC Control: This program communicates with the connected channel modules via the 
connected master controllers. Monitoring the cells voltage, current, and temperature, while also 
executing the user defined protocol files, and controlling charge/discharge profiles of the channel 
modules.  

UHPC Protocol: This program is used to generate the test sequence protocol files that dictate how 
a charger channel will operate for a given cell. It allows the user to configure currents, voltage 
limits, data collection intervals etc. 

UHPC Plot: This program allows the user to analyze data files generated by the UHPC Control 
software.  It provides both a graphical interface for viewing of data and a data export section that 
allows the user to export simple text files for subsequent graphing and further analysis. 

4.2 Software Installation 

4.2.1 Software Installation 

If updating from any version’s earlier than 2.5.0, the software will need to be manually uninstalled 
from Windows “Add Remove Programs” after updating the software. Otherwise, for all later versions 
the installer will automatically replace the current installation, so ensure that the UHPC Control 
software is not running during installation. 

1. Run the .msi file in the .zip folder provided by NOVONIX containing the UHPC software. 
2. Install to the default directory. 
3. Launch the application.  
4. Once installed, read this UHPC manual (In the software toolbar: Help -> Help Manual) for 

up-to-date information on how to operate the software.  
5. All previous settings and configurations should remain unless otherwise stated in the 

release notes. 

 

4.2.2 First Time PC IP Address Setup 

This will have been completed for NOVONIX supplied UHPC Desktop PC’s, but in the case of 
replacement PC’s or third-party PC’s the following steps will need to be completed to set up the 
network configuration to communicate with the UHPC hardware. 

The two default IPs are “172.29.9.1” and older systems may be “192.168.1.1”.  
 
A quick explanation can be found below though in Figure 1 and Figure 2.  
In the Windows search bar type and left click "View network connections".  

 

 

https://www.novonixgroup.com/customer-area/
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• Right click the unidentified network (master controller). Click “Properties.”  
 

 
 

 
• In properties, click the “IPV4”.  
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Figure 1: Navigating to PC Network Configuration 
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Figure 2: PC Network Configuration 
 

• Once the user has navigated to the IPV4 configuration page, the IP Address should be filled 
out with one of the two default IP’s given above, but with the following exception: The final 
digit should be incremented by at least 1. This is to establish a standalone network for 
connection. 

 

• After setting the IPV4 configuration, try running “Troubleshoot Network” from UHPC. If it 
fails, adjust the IPV4 to the other unique IP given above, increment the final digit by 1, and 
try again. 

 

 

 

 

 

 



 

13 
 

5. UHPC Control Software User Manual 

5.1 Main Control Software Operation 

After the channel control module has fully powered up and all channel modules are operational 
(wait 30 seconds after powering ethernet module before turning on channel modules), the 
NOVONIX UHPC Control software can be started. A shortcut can be found on the desktop. 

 

The main screen will look like this, varying based on channel count and selected settings: 

 

Figure 3: Main screen layout panels 
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5.1.1 Menu Options 

File Menu 

 
Figure 4: File drop-down list menu 

 

UHPC Protocol Designer (1):  

This launches the UHPC Protocol Designer program, which is used to generate test protocols that 
documents the series of control steps to be run on channel that are assigned that protocol file 
(*.pro1, *.pro2). 

More information on UHPC Protocol can be found in the UHPC Protocol Software Designer Manual 
portion of this document. 

 

UHPC Plot (2):  

This launches the UHPC Plot program that is used to analyse the data files collected and generate 
summary data files for subsequent graphing with external programs such as Open Office®, Microsoft 
Excel®, Golden Software Grapher®, etc. This program allows the user to view graphical 
representations of the data collected both when cells are running and after testing.  

 

More information on UHPC Plot can be found in the UHPC Plot Data Analysis Manual portion of this 
document. 

 

Open Backup Datafile Location (3): 

This opens the datafile folder found in C:/Novonix/UHPC Backup containing the backups to channels 
recently ran on the current network configuration. These files are held in this folder typically forever, 
or until a test with a duplicate file name is ran. 
 
 

Exit (4):   

This will prompt the user to confirm that they wish to shut down all channels and close the program. 
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Tools Menu 

 

 
Figure 5: Tools drop-down list menu 

 
 

Diagnostics (1):   

Tool for troubleshooting network issues, flashing LED’s on specific channels, and generating 
diagnostic reports for troubleshooting with NOVONIX customer support. In diagnostics, password 
restricted advanced diagnostic controls can also be found for communicating with the channel 
modules manually. 

 

For customer support, please see the contact us section of this document. 

 

Settings Menu 

 

 
Figure 6: Settings drop-down list menu 

 

Startup Configuration (1): 

Configures settings that affect the program at start-up. This menu is described further in the Startup 
Configuration section. 

 

Column Configuration (2):  

Change column names and set whether they should be displayed or hidden. This menu is described 
further in the Column Configuration section. 

 

Safety Limits (3):  

Check and set safety limits used to monitor channels and alert if limits breached. This menu is 
described further in the Safety Limits section. 
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Help Menu 

 
Figure 7: Help drop-down list menu. 

Getting Started First Test (1): 

Launches the Getting-Started-First-Test.pdf to help users set up and execute their first UHPC test. 
 

System Manual (2): 

Launches the System Manual for the UHPC Control Hardware. 

 

Help Manual (3): 

Launches the Help Manual for the UHPC Control program (this document). 

 

Release Notes (4): 

Launches the release notes .pdf for the current UHPC Control program containing all the changes 
iterated by version. 

 

Factory Reset (5): 

Resets almost all UHPC Control configuration data. System limits, Global Limits, Startup 
Configurations, Column Configurations are all removed and set to default values. Snapshots and 
backups are retained. 

 

Check for Update (6): 

Manually makes a check with the NOVONIX customer portal to check for updates. This is also done 
automatically once daily unless the user disables it in Startup Configuration. No information is 
shared with NOVONIX or downloaded automatically during this call.  

 

Contact Us (7): 

Provides the user a popup containing the NOVONIX customer support email address, this 
information can also be found at the bottom of this document in the “Contact Us” section. 

 

About (8): 

Provides information on the NOVONIX UHPC Control program version and third-party licensing. 
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5.1.2 Channel Control Grid 

Note: A number of these settings are toggleable in the settings menus. 

 

 
Figure 8: Channel type filters display, with suspended channels selected. 

 

Channel Type Filter:  

Selecting an option (e.g., Idle, Running, Loaded, etc.) will display only the channels that fit the 
selection.  Multiple types can be selected at one time. Selected filter types will be highlighted green. 
If no channel type filters are selected, then all channels will be shown. 

 

 
Figure 9: Status indicator, as well as start and suspend buttons. 

Status:  

The status of the channel (shown above as “Idle”) will display the state of the channel at that 
moment. 

 

Start button:  

This button is only active for a given channel when it is in the idle state and loaded (i.e. both the 
protocol file and data file have been selected). Clicking on the button will immediately start the 
channel. Its label will change to Stop. This button can then be clicked to stop the channel. You will 
be prompted to confirm that you wish to stop the channel. 

 

Suspend button:  

This button is only active for a given channel once it is running a protocol file. Clicking on the button 
will prompt you for whether you wish to suspend operation of the channel. Selecting less will turn off 
current to the cell. The button’s caption will change to Resume. Clicking the button when it says 
Resume will immediately resume operation of the channel. 

 

Channel:  

The channel number for the row, starting at 1. 
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Append Data:   

When checked, the user may select a pre-existing datafile. Data will be written to the end of the 
selected datafile. When Append Data is clicked, if a datafile is loaded already, or if a data file is 
loaded after clicking append data, Cell Capacity, Cell Mass, and Protocol File*(V2.10.0 datafile and 
above) will be loaded automatically in the data grid for the channel. Additionally, run time, 
Cumulative Capacity, Cycle #, and Step # will also be pulled from the last line on the existing datafile 
and used when starting the test. No header new lines will be written.  

This option can be configured in Settings -> System Configuration -> Features -> Append Data 
Settings.  

 

 

Figure 10: Append Data Settings Window 

Description column:  

Allows the user to enter a text-based description to be written to the header of the data file. (The data 
file header also contains information such as channel number, date started, capacity, active mass, 
protocol file used, etc.) 

 

Barcode:  

Allows the user to enter a barcode description for the cell. The entered barcode will not impact 
anything. 

 

Cell ID:  

Allows the user to enter a cell ID description for the cell. The entered cell ID will not impact anything. 
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Mass column:  

Allows the user to enter a cell active mass if using a protocol file that contains steps based on active 
mass (e.g., a current entered in A/g). If no mass is entered, this value will default to 1 g. If no specific 
currents are used in the test protocol, the entered mass will not impact anything. 

Capacity column:  

Allows the user to enter a cell capacity if using a protocol file that contains steps based on capacity 
(e.g., a current entered as a C-rate or a C/xx rate). If no capacity is entered, this value will default to 
1 Ah. If no C-rates are used in the test protocol, the entered capacity will not impact anything. 

 

Area column:  

Allows the user to enter a cell area if using a protocol file that contains steps based on area (e.g., a 
current entered in A/cm2). If no area is entered, this value will default to 1 cm2. If no specific currents 
are used in the test protocol, the entered mass will not impact anything. 

 

Data file column:  

Allows the user to select the data file to be used for a cell that they wish to run. Clicking on the label 
will bring up an explorer window pointing to the last directory where data was saved. Data is stored 
in a simple comma separated ASCII text format (*.csv file type). This file type will typically open by 
default with Microsoft Excel®, if installed. 

 

Protocol file column:  

Allows the user to select the test protocol file (created in the protocol designer - see the Protocol 
Step List Panel section and/or UHPC Protocol help document) to be used to run a file. 

 

Channel status columns:   

The Run time, Step time, Current, Potential, Step Capacity, Cumulative Capacity, and Cycle # 
columns provide information on the current state of the channel. The Active Step Display column 
shows a description of the protocol step currently running. Clicking on the label for a channel in this 
column will bring up a list of the steps to be run on that channel. 

 

Chamber Name:   

The Chamber Name is used to differentiate NOVONIX IP-enabled thermal chambers assigned to 
channels. 

 

Chamber Temperature:   

The Chamber Temperature displays the temperature for any channel with a connected IP-Enabled 
thermal chamber. If no configuration exists for that channel or the chamber is not connected, “---” 
will be displayed. 
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Linked EIS Device:   

The Linked EIS Device column will display the associated EIS Channel # and the EIS Model # for any 
channel that has an EIS device assigned. To assign or unassign an EIS device, right click the channel 
and select “Assign EIS Device”. 

 

5.1.3 System Log Panel 

This panel provides a log of system events (starting and stopping channels, etc.). 

 

 
Figure 11: Error log displaying controller connection issues. 

 

 
Figure 12: Communication log showing communication links being opened. 

 

View Error Logs:   

Opens the default Windows Explorer folder for the error logs.  (C:\Novonix\UHPC Log 
Files\ErrorLogs) 

 

View Comm Logs:   

Opens the default Windows Explorer folder for the communication logs. (C:\Novonix\UHPC Log 
Files\{System Name}) 

 

Clear:   

Clears the logs displayed on the screen. To permanently delete logs, use the View Error Logs/View 
Comm logs buttons and delete files using windows file deletion. 
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5.1.4 Selected Channels & Batch Control Panel 

Displays all channels currently selected (selected panels will be highlighted on the control panel).  

 

 
Figure 13: The selected channels panel, with three channels (01, 02 and 03) selected. 

 

Batch Control:   

Will bring up a window to assign values to all the channels in the “Selected Channel” list shown above. 
(See the Batch Control Panel section for more details). 

 

Start:   

Used as a quick batch command to start all channels selected. If all channels currently selected are 
running the button will switch to “Stop.” If there is a mix between running and idle channels, this 
button will be disabled. 

 

Suspend:   

Used as a quick batch command to suspend all channels selected. If all channels currently selected are 
suspended the button will switch to “Stop.” If all channels selected are not either suspended or running, 
this button will be disabled. 

 

5.1.5 Protocol Step List Panel 

The protocol step list panel displays the protocol file of the currently selected channel. If multiple 
channels are selected, the first channel that was selected will be displayed. The user has right click 
options on each step in the protocol step list. Each protocol step action can only be applied to one 
step per channel at a time. 

 

Protocol Step List:   

This view of the control software represents the condensed view that shows looping steps. 
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Figure 14: Condensed protocol step list view. 

 

Protocol Step List (Expanded): 

This view of the control software represents all the steps expanded out in the sequential order in 
which they will be executed. 

 

  
Figure 15: Expanded protocol step list view. 
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Figure 16: The protocol step list right-click menu. 

 

Start from this step (1):   

If the channel is in the Idle state, this option allows the user to run the channel from the step 
selected. 

 

Jump to this step (2):   

This command will cause the channel to immediately go to the step selected, ending the current 
running step. If the channel is suspended, using this command will resume the channel as well. 

 

Jump to this step after current step finished (3):   

If the channel is running, using this command will cause the channel to navigate to the step selected 
after the current step is finished. This command causes the selected step to be highlighted in blue 
in the expanded protocol step list. 

 

Suspend after this step (4):  

After selecting this option on a step, when that step finishes the channel will be suspended until 
manually resumed. This command causes the selected step to be highlighted in yellow in the 
expanded protocol step list. 

 

Edit this Step (5):  

After selecting this open, an edit step conditions dialog box will appear, as shown in Figure 17. 
Currently only Current, Units, and Voltage target may be edited.  
 
Warning: This change has not yet persisted across snapshots. When resuming from snapshots, be 
sure that any changes that are still required for current or future steps are adjusted accordingly. 
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Figure 17: Edit Step Conditions Dialog Box 

 

Remove Step Instruction (5):  

Available only in ‘expanded’ mode of protocol list, after selecting this option on a step, this 
command causes the selected step to be removed from the protocol list. Only future steps may be 
removed. 

Warning: This change has not yet persisted across snapshot saves; If the test is resumed from 
snapshot after the test has passed a removed step, unintended behavior can occur. In these 
cases, be sure to jump to the correct step after restarting from snapshot. 

 

 
Figure 18: Loop menu displayed when making an action to a step in condensed view. 
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Choosing position in repeating steps:   

When choosing one of the right-click options outlined above in compact protocol step list view, a 
window will pop up prompting the user to specify the loop number to execute the action within. 

 

5.1.6 Batch Control 

This feature assigns values to all the channels in the “Selected Channel” list, as described above in 
the Selected Channels Panel section. 

 

 
Figure 19: The batch control menu. 

 

Mass to assign (g):   

Entering a mass and clicking “Assign” will assign that mass to all selected channels. 

 

Capacity to assign (Ah):   

Entering a capacity and clicking “Assign” will assign that capacity to all selected channels. 

 

Protocol to assign:   

Clicking on the protocol file label (“Click to Select…”) will bring up file selector window, allowing a 
protocol file to be selected. Clicking “Assign file” will assign the specified protocol file to all selected 
channels. 
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Generate a data file name sequence: 

The batch control panel can be used to automatically assign sequential data file names to the 
selected channels. Clicking on the base file name label (“Click to Select…”) will bring up a file dialog 
where you can select the base file name to use. 

The check boxes beside “Add suffix Increment #” and “Add suffix Channel #” determine what to 
append to the base file name. Suffix increment # will add a number to the end of the base file name, 
while the suffix channel # will add the channel number as shown in the channel control panel. 

The “start at” box determines the number to append to the data file of the first channel in the 
selected channels list. The “# SigFigs” box determines the number of significant digits to display.  

As an example, with a base file name of “c:\UHPC data\Cell Sequence.csv,” selecting “Add suffix 
Increment #,” a “# SigFigs” value of 2 will assign the following file names to the channels in the 
Selected Channels List when the “Assign” button is clicked: 

 

C:\UHPC data\Cell Sequence-01.csv 

C:\UHPC data\Cell Sequence-02.csv 

C:\UHPC data\Cell Sequence-03.csv 

C:\UHPC data\Cell Sequence-04.csv 

C:\UHPC data\Cell Sequence-05.csv 

 

The buttons at the bottom of the batch control panel are used to start, stop, suspend, resume the 
selected channels.  

 

Append Data:   

When checked, data will be written at the end of the file. No header lines will be written. 

 

Cycle Picker:   

The user can choose to start the channels from a specific step number or pick the spot in the cycle 
to start from. Selecting the “Cycle Picker” button will prompt the user with the protocol step list 
display (see Figure 18) in the Protocol Step List Panel section) where they can pick the spot directly 
from the list on where to start. 
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5.1.7 Startup Configuration 

 
Figure 20: Startup configuration menu. 

 

Tab Bar (1): 

Switch between general settings and extra features menus. 

1. Hardware & Feature Tabs: 
a. Adjust operator preferences in the configuration of UHPC. Click the “Setting Tooltip 

Toggle” beside an option for more information on each. 
2. Notifications Tab: 

a. Manage popups and user preferences during UHPC Control operation. 
3. Email Notifications Tab:  

a. Manage email notification settings on UHPC channel status changes. 
4. Advanced Tab: 

a. Administrator settings typically for enhanced control during beta feature 
development and higher risk user functionalities. 

 

Edit Channel Hardware and IP (6): 

Clicking this will open a window for the user to set the system name and IP of their master controller, 
as well as number of channels per system and type of system (2A, 10A, 20A). 
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Setting Tooltip Toggle (3): 

Clicking here displays detailed information for that setting in the tooltip display panel. 

 

Settings Value Box (4): 

Input area to change the value of the setting directly to its left. 

 

Tooltip Display Panel (5): 

Tooltip information is displayed here to explain the setting directly to its right. 

 

Add, Edit, Remove Thermal Chamber Config (6): 

Click this will open a window for the user to configure individual connected IP-enabled Thermal 
chambers. For more information see Appendix A – Temperature Control. 

 

Reset Configuration (7): 

Clicking this will prompt the user to reset all UHPC Control Configurations to default values. A 
software restart is recommended to ensure all default values take effect. 

 

5.1.8 Diagnostics 

The Diagnostics page, seen below in Figure 21, is to help the user troubleshoot the system, and aid in 
customer support.  

 

Troubleshoot Network:  

This button begins a network diagnostic test to try and determine the IP of the UHPC Hardware and 
establish a connection if possible. 

The two default IPs are “172.29.9.1” and older systems may be “192.168.1.1”.  

If the system is turned on and properly connected and this test fails to establish a connection, the 
issue is that the PC hasn’t been configured properly. See section First Time PC IP Address Setup 

or contact us for network configuration details.  

 

Flashing LED Test:  

Clicking this button will flash the LED on the connected UHPC Channel Module(s). The “CH: All” 
dropdown box can be clicked to choose a specific channel. The channel(s) selected will flash for 30 
seconds before the test halts. 
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Generate Diagnostics Report:  

This is used to generate a diagnostic report containing the characteristics of connected UHPC 
hardware. This report may be requested by NOVONIX customer support when troubleshooting 
UHPC issues. This report takes several minutes to complete. When complete, a button “Open Latest 
Report” will also appear beside “Clear Log”. 

 

 

 

Figure 21: Diagnostics Panel 

 

Advanced Diagnostics 

The Advanced Diagnostics panel is available only to administrative users. Its intended purpose is to 
aid in NOVONIX customer support directly working with users to troubleshoot and resolve system 
issues.  
 

Advanced Calibration 

The Advanced Calibration panel is available to administrative users and certified third-party 
calibrators. Its intended purpose is to set calibration coefficients through software and help ensure 
the accuracy of the UHPC system. 
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5.1.9 Column Configuration 

 

Figure 22: Column configuration menu. 

 

Display:   

Controls whether a column will be displayed or not (this will not affect what is being saved to the 
data file).    

 

Name: 

The title of the column. Only some columns can be edited. 

  

Description: 

The description of the column. This is a non-editable field. 
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5.1.10 Safety Limits 

This window displays the maximum and minimum values that are allowed while running cells. 
Clicking the edit button will prompt a password dialog. Only those with a password can change the 
limits. Changing the global limits to values more restrictive could cause channels to shut down if the 
limits are passed. 

 
Figure 23: Safety limits menu, showing the default global limits view. 

 

5.1.11 Restart from Previous Snapshot Data 

Click the “Restart from previous channel snapshot” to bring up a list of saved snapshots. The list of 
snapshots represents the snapshot that is being written every second a channel is running. Archived 
snapshots are saved on a time-based interval which is defaulted to 1 hour. 

Select the snapshot(s) you wish to start running again (you can hold down the left mouse button and 
drag or use ctrl to single click multiple entries). To complete this process, click “Load Selected 
Snapshots.” 

 
Figure 24: Menu to select specific snapshots to start. 

 



 

32 
 

Continue Writing to Existing Datafile (1):   

The default option, clicking this radio button will cause restarted snapshots to resume writing from 
where they left off in the datafile.  

 

Overwrite Existing Datafile (2):   

Clicking this radio button reuses the existing datafile but erases all previous data. 

 

Create New Datafile (3):   

Clicking this radio button creates a new datafile for each snapshot when restarted. Previous data 
will not be included in the file. The new filename will be the previous file name with a timestamp 
appended on the end in the format of “-yyyy-MM-dd_HHmm.” 

 

Snapshot list Channel Grid (4):   

Snapshot details per channel will be listed in the grid, and channels can be selected individually with 
left mouse click, or in groups with shift/ctrl+click. 

Right clicking a channel result in a dropdown, shown below in Figure 25. Change Channel can be 
used to move a snapshot to another channel. Protocol and datafile can be edited, and additional 
snapshot information can be seen with “View Detailed Information.”  

 
Warning: Changing the protocol file can result in unintended consequences. In these cases, it’s best 
to immediately examine the channel upon restart and ensure the step is loaded correctly. “Suspend” 
+ “Jump to step” from the channel protocol description may be helpful in these situations. 

 

 

Figure 25: Snapshot Channel Right Click Dropdown 

 

View Archived Snapshots (5):   

This button will change the dialog screen to a list of archived snapshots. These “snapshots” of 
snapshots are taken once every hour while tests are running and are stored for up to 2 months. Each 
list will represent the state of the system at the time of the archived snapshot state. Selecting an 
archived snapshot list or selecting latest running snapshot for each channel will reload Figure 24 
with the snapshots at that time. Resuming snapshots from the past may result in datafiles with 
inconsistent timestamps or repeat previous steps. 
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Figure 26: Initial snapshot date choice menu. 

 

Show snapshots for stopped or idle channels (6):   

By default, stopped channels are not displayed on this list, only channels that were running when 
the software was shut down (unless all channels were stopped at once). Similarly, if a user restarts 
only a portion of the channels with snapshot, the remaining channels will be marked as idle and 
hidden as well. The intent is that only the most active channels should be displayed to be restarted 
from snapshot, rather than displaying all channels all the time. Clicking this checkbox will display all 
previously stopped and idle channels.  

Hide Running Channels (7):   

Running channels are displayed by default, primarily so that users can see that snapshots are 
actively being recorded. If restarting idle channels while other channels are running, clicking this 
checkbox will hide active channels, only displaying the remaining channels. This checkbox should 
be used in conjunction with “show snapshots for idle/stopped channels.” 

Load Selected Snapshots (8):   

When snapshot(s) have been selected with the left mouse button (or ctrl/shift click to select multiple 
snapshots), clicking this button will begin the process to restart all selected channels from 
snapshot. 

Right Click Menu (9):   

When a single snapshot has been selected, and the right click button pressed. A dropdown menu 
will appear allowing the user to change the channel the snapshot is assigned to, as well as changing 
the datafile, protocol file, and some detailed information about the snapshot. 

Warning: When changing the protocol file, the snapshot will resume on the same step number it left 
off on, this can result in unintended behavior if the steps have been reordered or reduced. 
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5.1.12 Temperature Linking 

Temperatures can be linked between channels by selecting two or more channels, then right-
clicking and selecting Link Temperature(s).  

 

 
Figure 27: The right-click menu showing the Link Temperature(s) option. 

 

The anchor is the channel that copies its temperature to the other channels. The color will display 
will indicate which channel is the anchor. 

 

 
Figure 28: The temperature assignment menu. 

 

 
Figure 29: Linked temperatures as assigned by the previous box. The anchor channel is the topmost channel.  
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5.1.13 Voltage Linking 

Voltages can be linked by selecting two or more channels, right-clicking, and selecting the Link 
Voltage(s) option. Note that only Idle channels can be assigned voltage links. 

 
Figure 30: The right-click menu showing the Link Voltage(s) option. 

 

Unlike temperature links, voltage links involve the use of a reference as well as a base channel. 

• The base channel saves the voltage data from all other connected channels along with its 
own output data. 

• When the base channel has a protocol that checks the “ref voltage” value, it checks the 
voltage of the reference channel and performs the step operation based on that value 
(rather than its own voltage). 

• Non-base, non-reference channels have their voltage data saved along with the base 
channel’s.  

 

 
Figure 31: Menu prompting for a base, reference, and representative colour for the new link. 
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5.1.14 Snapshots with Voltage and Temperature Links 

Snapshots cannot be imported onto channels with existing temperature or voltage links, or channels 
that are not in the Idle state. Attempting to import onto a channel with links or that is running will not 
succeed. 
 

 
Figure 32: Notification showing user cannot perform the requested action. 

If the colour assigned to the temperature or voltage links of the snapshot channel is already in use 
by a channel in the program, the program will dynamically re-assign a colour to the imported 
snapshot channel. If this is not possible, the program will display an error. 
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6. UHPC Protocol Software Designer Manual 

6.1 Main Protocol Software Operation 

The protocol designer software is used to develop a test protocol to be used with the UHPC Control 
program. The test protocol details the sequence of test steps to be performed on a cell. A given 
protocol file can be used for multiple channels.  

When you first start the protocol designer software, you will be prompted to select the channel type 
to develop a protocol for (e.g., 2 A UHPC channels or 20 A UHPC channels). 

 

 
Figure 33: The UHPC Protocol login prompt. 

 

 
Figure 34: The main screen of the program when first loaded. 

 



 

38 
 

6.1.1 Control Options 

 
Figure 35: Each of the protocol control step options with their default values. 

 

Open Circuit Storage:   

This will measure open circuit voltage as a function of time for a fixed storage period specified by the 
user in the trip condition. Data will be saved when the open circuit voltage changes by a fixed amount 
specified by DV (e.g., 0.005 V) or when a fixed time interval passes, specified by Dt (e.g., 5 minutes). 
These two parameters are not mutually exclusive - data will be saved when either parameter is 
reached and then the start point for the next data interval will be reset for both parameters. 

 

Constant Current Charge: 

The cell will be charged at constant current (specified by the user) to a voltage limit. A time trip 
condition is also recommended. Typically, this period is used to be longer than the time expected for 
the cell to charge and acts as a safety limit. For example, if a C/20 charge is used with a 25-hour time 
trip and the cell develops a short and does not reach the voltage trip point after 25 hours, it will move 
to the next step.  

The following units are available for the current:  

• A, mA, µA:  current will be in the specified absolute units. The current is restricted to the 
range 1 µA to 1A. 

• A/g, mA/g, µA/g:  These units are designed to be used when an active mass is entered in the 
control program.  

• xx-C, C/xx: These units are designed to be used when a cell needs to be charged at a 
particular C-rate. The values would be coupled with the cell capacities entered in the main 
control program. If 2 is entered in the numeric field for xx-C units, this indicates a 2-C rate. 
If 2 is entered in the numeric field with the C/xx units, this indicates a C/2 rate. 

 

Constant Current Discharge: 

The cell will be discharged at constant current (specified by the user) to a voltage limit. A time trip 
condition is also recommended. Typically, this period will be longer than the time expected for the 
cell to discharge; it then acts as a safety limit should, for example, the cell develops a short and not 
reach the voltage trip point.  
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CC-CV Charge:   

This step control type will charge the cell at constant current to the specified voltage limit and then 
hold the cell at that voltage for a period. The constant current (maximum charge current) and the 
hold voltage to be used are both entered by the user. When the voltage reaches this limit, the current 
will gradually reduce to maintain the cell at this voltage. The cell may slightly overshoot and then 
oscillate around the set-point before settling. 

There are separate trip conditions for the overall and CV portions of the step. There are no specific 
trip conditions related to the CC portion of the step. 

• The first trip condition will stop the step and move on to the next step if the TOTAL step 
time (CC + CV) exceeds the time entered by the user.  

• The second trip condition will stop the step and move on to the next step if either the CV 
hold time exceeds the time entered or if the amperage of the measured current drops 
below the value entered by the user.  

The same range of units available for the constant current control are available for the trip conditions 
on the constant voltage control. 

 

CC-CV Discharge: 

This step control type will discharge the cell at constant current to a voltage limit and then hold the 
cell at that voltage for a period. The constant current (maximum absolute discharge current) and the 
hold voltage to be used are both entered by the user. When the voltage reaches this limit, the 
amperage of the current will gradually reduce to maintain the cell at this voltage. The cell may slightly 
undershoot and then oscillate around the set-point before settling.  

There are separate trip conditions for the overall and CV portions of the step. There is no specific trip 
conditions related to the CC portion of the step.  

• The first trip condition will stop the step and move on to the next step if the TOTAL step 
time (CC + CV) exceeds the time entered by the user.  

• The second trip condition will stop the step and move on to the next step if either the CV 
hold time exceeds the time entered or if the amperage of the measured current drops 
below the value entered by the user.  

The same range of units available for the constant current control are available for the trip conditions 
on the constant voltage control. 

 

Repeat Step(s): 

This step control type allows steps to be placed in a loop. The steps to be repeated will appear 
identical to the repeat step as per Figure 34 above. The repeat count value indicates the total number 
of times the steps in the repeat block will be run (i.e., a value of 2 means that each step will be run 2 
times). Multiple repeat steps can be included in a protocol and repeat steps can be repeated within 
other repeat steps, allowing for nested loops. 
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Increment Cycle Counter: 

An increment cycle counter step needs to be explicitly added for each time you would like the control 
program to increase the cycle number. This gives you full control over how you wish to define a cycle, 
rather than having it defined in a way that may not work for your test needs. This control type has no 
trip or save conditions attached to it. 

 

Set Temperature: 

A Set Temperature step control type allows for temperature control of NOVONIX IP-Enabled thermal 
chambers. When the set temperature step starts, a command will be sent to the thermal chamber 
temperature controller associated with the running channel. The temperature will be set once, and 
then run until the end step conditions are met. Step control conditions are described below, but by 
default for Set Temperature; Temperature Variance and Temperature Hold control conditions are 
used. Which cause the Set Temperature step to end successfully when the chamber temperature is 
held at the set point within the variance tolerance for the total hold time. Unlike the normal 
“temperature” condition, which uses cell temperature, Temperature Variance and Temperature 
Hold use the thermal chamber temperature. 

Because Set Temperature uses a specialized condition “Temperature Variance” where temperature 
is held at a specific value for a set amount of time, looking at Figure 36 will provide the minimum 
NOVONIX recommended temperature variance values based on target temperature. The default 
value for Temperature Variance is set to 1C to stay within this band during most use cases. 
 

 
Figure 36: Peltier Chamber Accuracy based on Temperature 

 

EIS: 

An EIS step control type allows for Electrochemical Impedance Testing (EIS) through use with a 
connected Gamry EIS module. Once an EIS step type is selected, the operator can choose from three 
types of EIS testing. 

Potentiostatic: The most commonly used EIS test, Potentiostatic mode is used when maintaining a 
constant voltage is crucial. This mode is ideal for studying the electrode processes and battery cell 
behavior at a fixed potential, making it useful for analyzing the stability and efficiency of the cell 
under a specific voltage. Researchers often employ this mode to understand the reaction kinetics 
and to identify the resistive and capacitive elements within the cell. 

You wouldn't want to run a test in Potentiostatic mode if the impedance of the cell is very high, as 
this could result in unstable voltage control and inaccurate measurements. 
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Galvanostatic: Galvanostatic mode is employed when a constant current is required during EIS 
testing. This mode is particularly useful for examining the response of a battery cell to steady current 
flow, which is representative of real-world operating conditions. It allows for the study of charge 
transfer resistance and mass transport processes, making it valuable for understanding the 
performance and limitations of the battery under consistent load. 

Avoid using galvanostatic mode if the cell has very low impedance, as maintaining a constant current 
can lead to excessively high or low voltages that may damage the cell or distort the data. 

 

Hybrid: Hybrid mode combines the features of both potentiostatic and galvanostatic modes, 
allowing for more versatile and comprehensive EIS testing. This mode can adapt to changing 
conditions by switching between maintaining a constant voltage or current as needed. It is beneficial 
for dynamic studies where the battery cell's behavior under varying loads and potentials needs to be 
analyzed, providing a more complete understanding of the cell's electrochemical characteristics. 

Hybrid mode may not be ideal if the system's response is highly non-linear, as the switching between 
voltage and current control could introduce artifacts or complicate the interpretation of the 
impedance data. 

As seen below in Figure 37, after selecting which EIS mode to run in, clicking “Configure” will open a 
configuration dialog for that EIS step. Please note: EIS values are not all validated by UHPC at this 
time, when creating a new EIS configuration, follow the Gamry recommend value ranges for your EIS 
device and testing scenarios. 

 

 

Figure 37: Configure EIS (Galvanostatic) Step Type 

For more information, please check the attached Appendix B – Gamry EIS Integration. 
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6.1.2 Control Conditions 

The control conditions show the logical representation on what action will happen when the conditions 
are fulfilled. Actions can be added by clicking the green + icon or by using the right click menu. Conditions 
can also separately be added or removed by the right click menu.  

 

 
Figure 38: Step control conditions, with each important segment highlighted. 

 

Action: 

Highlighted in yellow, the action represents what the channel should do when its “when” condition 
is satisfied. The options for the action control are: 

• End step, which ends the currently running step and proceeds to the next (if available), 
• End protocol, which jumps to the end of the protocol and sets the channel status to 

completed, 
• Pause protocol, which suspends the channel until it is manually resumed, 
• End loop, which exits the current loop and continues to the next step outside the current 

loop (if available), and 
• Save data, which saves channel information to the step’s data file. 

 

AND / OR:  

Highlighted in pink, the “And/Or” represents how the conditions are treated as a group. If a set of 
conditions are set to “And” then all grouped conditions must be met simultaneously before that 
corresponding action is taken. Alternatively, if “Or” is selected, any met condition will trigger the 
corresponding action. 

 

Left side condition:  

Highlighted in green, the left side condition is the left side of the condition’s comparison. It acts as the 
condition to be checked against, generally a unit or function of a unit(s).  
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Abbreviations for table below: 

• CC = Constant Current 
• CC-CV = Constant Current-Constant Voltage 
• OCS = Open Circuit Storage 
• Ch = Charge 
• Dc = Discharge 
• ST = Set Temperature 

All left side conditions available in the program are as follows: 

Condition Suitable for Use On Description 
ΔV OCS: Save data 

CC Ch & Dc: Save data 
CC-CV Ch & Dc: Save data during CC, save 
data any time 

Saves when the voltage has changed 
from its last save point value by the 
amount specified in the condition. 

Δt OCS: Save data 
CC Ch & Dc: Save data 
CC-CV Ch & Dc: Save data (all) 

Saves when the time elapsed has 
changed from its last save point value 
by the amount specified in the 
condition. 

ΔI CC Ch & Dc: Save data 
CC-CV Ch & Dc: Save data during CV, save 
data any time 

Saves when the current has changed 
from its last save point value by the 
amount specified in the condition. 

ΔQ CC Ch & Dc: Save data 
CC-CV Ch & Dc: Save data (all) 

Saves when the capacity has changed 
from its last save point value by the 
amount specified in the condition. 

Abs(dV/dt) OCS: All (except save data) 
CC-CV Ch & Dc: All (except save data) any 
time, all (except save data) during CC 

Saves when the absolute value of 
(ΔV/Δt) hits the specified value. 

Abs(dI/dT) CC-CV Ch & Dc: All (except save data) any 
time, all (except save data) during CV 

Saves when the absolute value of 
(ΔI/Δt) hits the specified value. 

Abs(I) CC-CV Ch & Dc: All (except save data) any 
time, all (except save data) during CV 

Saves when the absolute value of the 
current (I) hits the specified value. 

Step time OCS: All (except save data) 
CC Ch & Dc: All (except save data) 
CC-CV Ch & Dc: All (except save data) 

Trips when step time for the channel 
reaches the specified value. 

Hold time CC-CV Ch & Dc: All (except save data) any 
time, all (except save data) during CV 

Trips when the voltage has been held 
for the specified length of time. 

Temperature OCS: All (except save data) 
CC Ch & Dc: All (except save data) 
CC-CV Ch & Dc: All (except save data) 

Trips when the channel temperature 
reaches the specified value. 

Voltage OCS: All (except save data) 
CC Ch & Dc: All (except save data) 
CC-CV Ch & Dc: All (except save data) 

Trips when the channel voltage 
reaches the specified value. 

Reference 
voltage 

OCS: All (except save data) 
CC Ch & Dc: All (except save data) 
CC-CV Ch & Dc: All (except save data) 

Trips when the reference voltage 
reaches the specified value. This only 
applies on base channels. See UPHC 
Control manual for more information 
on base and reference voltages. 
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Highlighted in blue, the comparator is the selection on what the comparison relationship that needs 
to be fulfilled to satisfy the condition. The > symbol denotes that the left side condition is greater 
than the right-side condition; the < symbol denotes the left side condition is less than the right-side 
condition. Note that some left side conditions can only use one type of comparator. A +/- comparator 
exists for the Temperature Variance condition. 

 

Right side condition:   

Highlighted in red, the right-side condition is the right side of the comparison. The right-side 
conditions are user defined and input into the text box as shown in Figure 38 above. 

 

Right side units:   

Highlighted in purple is the selector for the units of the right-side condition. The units are associated 
with the left side condition. They may be set to one specific value (in which case they are expressed 
in plain text and not a drop-down box) or changeable by the user (as shown in Figure 38 above). 

 

6.1.3 Step Safety Limits 

For each step created, there are optional safety limits that can be added.  The default values for the 
step safety limits are derived from the protocol limits. To change these values to be more restrictive, 
click on the override checkbox beside the safety limit label (shown below highlighted in red). 

 

Cumulative 
Capacity 

CC Ch & Dc: All (except save data) 
CC-CV Ch & Dc: All (except save data) 

Trips when the channel cumulative 
capacity reaches the specified value. 

(%) 
Cumulative 
Capacity 

CC Ch & Dc: All (except save data) 
CC-CV Ch & Dc: All (except save data) 

Trips when the channel cumulative 
capacity percentage reaches the 
specified value. Requires capacity to 
be set in UHPC Control program to 
function correctly. 

Step Capacity CC Ch & Dc: All (except save data) 
CC-CV Ch & Dc: All (except save data) 

Trips when the channel step capacity 
reaches the specified value. 

(%) Step 
Capacity 

CC Ch & Dc: All (except save data) 
CC-CV Ch & Dc: All (except save data) 

Trips when the channel step capacity 
percentage reaches the specified 
value. Requires capacity to be set in 
UHPC Control program to function 
correctly. 

Temperature 
Variance 

ST:  All (except save data) Trips when the chamber temperature 
is within the specified value range of 
assigned thermal chamber. 
See Figure 38 for minimum 
recommended temperature variance. 

Temperature 
Hold 

OCS & ST:  All (except save data) Required Temperature Variance step, 
when paired, hold time begins when 
chamber temperature variance is 
stabilized.  
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Figure 39: The step safety limits, with override box highlighted in red. 

 

Apply all steps:  

Copies all the limits as specified by the user to all other steps in the protocol, where applicable. 

 

6.1.4 Step Manipulation 

Selecting the green + icon will add a step underneath whatever step is currently selected. The “trash 
can icon” is used to delete any steps that are selected. Extended step manipulation options are also 
available from the drop-down menu that appears when right clicking on a control or condition step.  

The available button/options are: 
 

Add Step:  

This will insert a new step above the currently selected step. If a step within a repeat block is 
selected, then this will insert a new step inside the repeat lock above the selected step. If a repeat 
step is selected, then this will insert a new step above the repeated step. 

 

Loop items: 

This will insert the currently selected step into a newly created “Repeat steps below” step. 

 

Copy: 

Copies the selected step(s).  

 

Paste before:  

If there are step(s) that have been copied, this command will insert the copied step(s) above the 
currently selected step. 
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Paste after:  

If there are step(s) that have been copied, this command will insert the copied step(s) below the 
currently selected step. 

 

Delete:  

This will delete the currently selected step(s). 

 

There is additional functionality outside the right-click menu, described below: 

Drag and drop:  

Users can move steps around by clicking while holding the mouse button down, and then dragging 
above below or into a loop. 

 

 
Figure 40: Dragging a step. 

 

Change step type:  

Users can change the step into a different step by double clicking on the step’s name.  A dialog will 
open prompting the user to select the type of step they wish to change their selection to. 

 

 
Figure 41: The step selection menu, pulled up by double-clicking the “CC-CV Discharge step.” 
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6.1.5 Menu Options 

File Menu: 

 
Figure 42: The File drop-down menu. 

 

New (Ctrl+N): 

Creates a new protocol file, which is then displayed in the protocol tabs area. 

 

Open (Ctrl+O): 

Opens an existing protocol file for modification. 

 

Save (Ctrl+S): 

Saves the currently selected protocol file to the default file location, with its currently assigned 
name. 

 

Save As: 

Saves the currently selected protocol file to a new location and/or with a new name. 

 

Copy (Ctrl+C): 

Copies the currently selected protocol control step(s) or step control condition(s). 

 

Paste (Ctrl+V): 

Pastes the item(s) currently on the clipboard (items that were previously copied), if possible. 

 

UHPC Control:  

This launches the UHPC Control program, which is used to run control steps for channel(s) that are 
assigned a protocol file (*.pro1, *.pro2) made from this application.  
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UHPC Plot:  

This launches the UHPC Plot program that is used to analyse the data files collected and generate 
summary data files for subsequent graphing with external programs such as Open Office®, Microsoft 
Excel®, Golden Software Grapher® etc. This program allows the user to view graphical 
representations of the data collected both when cells are running and after testing.  

 

Exit: 

This will prompt the user to save any unsaved protocol files that they wish to keep, then closes the 
program. 

 

Options Menu 

 
Figure 43: The Options drop-down menu. 

 

Global Limits:   

Opens the window for configuring global protocol safety limits. More information can be found in the 
Global Limits section below. Requires an administrator password from NOVONIX to access. 

 

Create or Change Configurations:   

Used to customize the default values for protocol control steps, step control conditions, and user 
management. More information can be found in the Default Configurations section below. 

 
Help Menu 

 
Figure 44: The Help drop-down menu. 

 

Help Manual:  

Launches the Help Manual for the HPC Protocol program (this document). 
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How to use custom variables: 

Opens a PDF guide on utilizing custom variables to use advanced testing conditions. 

 

Getting started first test: 

Opens a PDF guide on conducting UHPC tests. 

 

Check for update: 

Checks the NOVONIX Customer Portal for available updates, and then offers to download them. 
Requires network connection. 

 

Factory Reset: 

After suggesting all other UHPC applications are exited, removes all configuration files associated 
with UHPC Protocol, including Global Limits, System Limits, User Configurations, and saved 
application settings. Deleted files are those found in C:/NOVONIX. 

 

Contact Us: 

Provides the email address of NOVONIX UHPC customer support. 

 

About: 

Provides information on the NOVONIX UHPC Protocol program. 

 

6.1.6 Global Limits 

 
Figure 45: The Global Limits menu, as accessed by a supervisor account (fields can be edited). 

https://www.novonixgroup.com/customer-area/
mailto:BTS-Support@novonixgroup.com
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Global limits are the safety limits set by an administrator role. To view/edit the rules, a supervisor 
password is required (or view them on UHPC Control). The maximum and minimum values for the 
bars are the system limits that are set in the control software. The default system limits are based 
off the channel type (2 Amp, 10 Amp, 20 Amp) chosen at start-up. These limits are also used as the 
default values for the step safety limits. 

 

6.1.7 Default Configurations 

The default configurations menu can be displayed both with the menu option (Options > Create or 
Change Configuration), or with the “create or change configuration” button displayed above the 
protocol control steps and step control conditions areas of the window. 

 
Figure 46: The configuration menu opened and showing the default values for the Open Circuit Storage 

protocol step. 
 

Step Controls Conditions:  

These areas function the same way as setting step control conditions and limits for an individual step 
inside a protocol. Selecting the step type will display the default conditions and safety limits 
associated with that step. In the image above Open Circuit Storage is selected, so the conditions 
and safety limits shown below are the defaults that will be used whenever a new Open Circuit 
Storage step is created with the configuration applied. (See Control Conditions section for more 
detail) 

 

Saving Configurations:  

To save a new configuration simply change the save name (defaults to “Default Configuration”) and 
click the “Save Changes” button. A new entry will be created and attached to the logged in 
username. Using different users’ configuration is permitted, however, saving changes will save the 
configuration under the username of the user who made the changes. 

Exit Configuration:  
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To leave the Configuration screen, click the “Exit” button. 

   

Manage Configuration:   

Click “Manage Configurations” to choose from a list of all configurations. Double click to select 
configuration. Right-click to bring up a context menu to either user or delete the configuration. 

 

 
Figure 47: Configuration selector showing the “right-click” menu. 

 

Default Configuration:  

Click “Use this config on Login” to use the configuration as the currently logged in user’s default. The 
button will be disabled and be surrounded by a green square (as shown above) when it is currently 
the default configuration. 
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7. UHPC Plot Data Analysis Manual  

7.1 UHPC Plot Software Operation 

A graphical data viewing and analysis program has been included with the NOVONIX UHPC system. 
This program allows the user to view a range of plots for multiple cells and generate summary text-
based data files for subsequent analysis through programs such as Microsoft Excel®, Golden 
Software Grapher®, etc.  A shortcut can be found on the desktop and in the start menu under the 
NOVONIX folder.  

It is important to understand that several of the values that can be plotted are calculated from the 
raw data files and that, in some instances, the NOVONIX plot software uses internal algorithms to 
ensure the values are presented correctly. Care must be taken if you intend to work with the raw data 
files directly. 

Starting up the application will prompt a file explorer window that will allow you to select the files 
you wish to analyse first. If you select ‘cancel,’ no graphs will be shown on the main page; however, 
you can still choose to add more files once the main screen is shown.  

 

 

 
Figure 48: The main UHPC Plot view, showing two data files plotted across four graphs. 

 
 

In the default configuration, four standard graph panels will be shown, with the data for multiple files 
shown in different colours overlaid on each panel. The default standard graphs are: 

• Voltage vs. Cumulative Capacity,  
• Coulombic Efficiency vs. Cycle Number,  
• Charge Capacity vs. Cycle Number and  
• Discharge Capacity vs. Cycle Number.  
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7.2 Data File Panel and Graph Settings Bar 

7.2.1 Data File Panel 

 
Figure 49: The data file panel's command buttons. 

 

The panel on the left lists the data files loaded. Un-checking a file will remove that file from the 
graphs. Right clicking and then selecting “Delete File(s)” on a selected file will remove all selected 
files from the list.  

 

Home screen: 

Clicking the “home” button (Figure 49, first on right) will return the view from the Multi Panel to the 
default, four-graph view.  

 

View Files Separately: 

Clicking on the “view files separately” button (Figure 49, second from right) (or selecting File -> Multi 
Panel) will allow you to view whatever files are selected individually. Each file will have its own graph, 
as shown below. 

 

 
Figure 50: Multi Panel view showing the two loaded files separately. 
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Save: 

Clicking on the “save” button (Figure 49, third from the right) (or selecting File -> Save) will bring up 
a new form, shown below. This form is used to generate ASCII text files that can be used to create 
presentation quality graphs externally.  

 

 
Figure 51: The top segment of the save form. Two other panels, unshown, are also part of the save form. 

 

Once you have selected the data files you wish to create, clicking the “Generate Files” button will 
generate all those files in the location selected. You will be prompted to select a base file name. 
Each data file generated will contain this name, together with the extension listed in the selected 
data file type. 

 

Reload default configuration: 

To reload the default configuration, click the corresponding button (Figure 49 above, third from left, 
star shaped). Clicking on the “reload default configuration” button will load the latest graph panel 
configuration. This can be changed according to user preference by selecting File -> Save page as 
default values from the top toolbar. The current graph panel configuration in view will be saved as 
the default. 
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Open: 

Additional files can be loaded by selecting File -> Open from the top toolbar, or by clicking the “open” 
button (Figure 49 above, first on left, folder shaped) and selecting the additional files needed.  

 

Reload: 

Selecting File -> Reload from the top toolbar or clicking the “refresh button” (Figure 49 above, second 
from left, circular arrow shaped) will reload the data files. This would typically be used to reload files 
for cells that are currently running on the system where the data is not currently shown in the graph. 

 

7.2.2 Graph Settings Bar 

 

 
Figure 52: The menu bar above the graph panels. 

 

Show Cycle(s): 

Enter in numbers separated by “,” or a range of cycle numbers for example “1-4”. Click on “Confirm” 
to update the graph display only the cycles specified. 

 

Gradient: 

The gradient feature shows a different colour shade for each cycle. The colour is based on the 
original colour for the cell. Moving the slider bar represents how much of a difference the color will 
fade from the previous cycle colour. To enable this feature, simply checkmark the gradient 
checkbox. 

 

Cycle Settings: 

This opens the Cycle Settings window shown below. Datafile cycles use the cycles created by the 
protocol during runtime, calculated cycles use an internal algorithm to determine the correct cycle 
distribution using the settings found under ‘Calculated Cycle Settings.’  Including the first half cycle 
is important for managing the first discharge, before a charge/discharge cycle. 

How the coulombic efficiency calculations are affected by cycles can also be configured in this 
window. 
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Figure 53: The Cycle Settings configuration window. 

Checking this box ensures that the first full cycle for each data file is correctly identified. This is the 
first complete charge step followed by a discharge step. This is important when a discharge step is 
used before the first charge step in a protocol, which can lead to erroneous UHPC parameter values.  

 

Chart Settings: 

Allows the user to select various chart display options such as line size, symbol size, etc. and toggle 
the display of legends and axes. “Drag left to reset zoom” can be disabled, causing dragging left on 
a graph to zoom in, similar to dragging right. Hover over settings options for tooltips. 

 
Figure 54: The chart settings menu. 
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7.3 Graph Panels 

 
There are two styles of graph:  

▪ Cell data plots all data points collected (e.g., voltage vs. capacity for multiple cycles).  
▪ Cycle data plots a summary point for each cycle collected. You can change the style of a 

graph by selecting the appropriate choice on the top of each graph.  

When plotting cycle data, there are added option boxes to allow the selection of only discharge cycle 
data, only charge cycle data, or both. You can change the parameters within a given graph style by 
clicking the “axis label” button and selecting from the list displayed. You can change the scale of the 
axes by clicking the “Axes” button and inputting the x or y-axis max min values. The export data 
button allows one to generate an ASCII text file for only the data contained on the current graph 
panel. 

 

Right clicking and dragging will allow you to freely move around the axis to view data points better. 
Left click and drag will allow you to draw a zoom in box to zoom in on any specific area. Ctrl left click 
will allow you to zoom vertically. Shift left click zoom horizontally.   

 

 Refresh button will reset the graph to default zoom.   
 

Export as PNG will save the graph in PNG format. 

 

The same list of files loaded on the front screen will be present in the left-hand panel list. The main 
part of the screen contains four lists of files that could be generated: 

 

Top Left panel:   

Cycle based summary data (e.g., Coulombic Efficiency v. Cycle number). This will generate a 
separate data file for each option selected. The data file will be arranged with Cycle number in the 
first column and then a separate column of data for each data file present. 

 

Top Right Panel:   

Time based summary data (e.g., Coulombic Efficiency v. Run time). This will generate a separate 
data file for each option selected. The data file will contain two columns for each data file. The first 
of these two columns will contain run time for each cycle and the second column will contain the 
summary value for that cycle. 

 

Bottom Left Panel:   

Raw data files. This will generate a separate file for each data file selected and for each of the output 
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file types in the list selected.  

 

Bottom Right Panel:  

Raw data files. This will generate a single file for each of the output file types in the list selected. Each 
file will contain two columns for each data file selected. 

 
Using the plotter: 

Keyboard/Mouse Input Graph Actions 
Ctrl + scroll wheel  Scale the plot by the y-axis 
Shift + scroll wheel Scale the plot by the x-axis 
Scroll wheel up Zoom into the graph, focused on the mouse 
Scroll wheel down Zoom out 
Click and drag right Zoom into the area of the displayed box 
Click and drag left Reset zoom to default 
Click and drag on an axis Pan in the x- or y-direction 
Double Click on graph Create Label on graph 

7.4 Data File Formatting 
 
The data files produced by UHPC Control and processed in UHPC Plot are .csv files. NOVONIX does 
its best to keep a consistent format to prevent custom parsers from requiring updates. 
 
The current format is as follows: 

 

 
Figure 55: Sample UHPC Data File 

 
Seen above in Figure 55 is the standard UHPC data file with headers at the top, and the beginning of 
the test results beginning on line 22 in this example. The headers of the data file contain a few lines 
that often need extra explanation and are typically just used for backend UHPC Plot Processing, 
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please see below for further explanation. 
 

Step Type: The step column is a number that represents the type of step being executed. See 
Figure 56 for a full list. 
 

 
Figure 56: Step Type List 

 
Step Position: Step position is used to help differentiate between start and end step types. 
 
Step Position 0 is used to indicate a regular datapoint in a step. 
Step Position 1 is used to indicate the first datapoint in a step.  
Step Position 2 is used to indicate the final datapoint in a step. 
Step Position 3 is used to indicate the first datapoint that reached end conditions in a step.  

 

7.5 Configuration Files 

 

The UHPC Plot software can generate and load configuration files (*.JSON files) that can be used to 
save a specific graph configuration setup and list of data files and load the setup later without 
needing to set the configuration as a default or redo the graph settings. 

By default, when starting the UHPC Plot software, the program can open both data files (*.csv) and 
configuration (*.JSON) files. Configurations can also be loaded manually through the File -> Load 
Configuration command from the top toolbar. Similarly, configurations can be saved using the File 
-> Save Configuration command from the top toolbar. 

 
Figure 57: The File drop-down menu showing the Load Configuration and Save Configuration options. 

 

In the event the configuration file is associated with data files that no longer exist or have been 
moved, the program will alert the user and still load the configuration, but without loading in the data 
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files that could not be found. If the data files were simply moved, opening them in the software and 
re-saving the configuration will allow them to be accessed again. 

Appendix A – Temperature Control 
Using the new NOVONIX IP-enabled thermal chambers, temperature of the thermal chamber can be 
controlled during a cell test without any operator intervention. Protocols can be created that specify the 
temperature set point, and how stable the temperature should be before proceeding to the next step. 
The following sections will help. 

 

Connecting a Thermal Chamber to UHPC Control 

 
1. Open UHPC Control Software 
2. On the top toolbar, click on Settings 
3. In the dropdown, click on Startup Configuration 
4. Click on Add Thermal Chamber (Green + Icon) 
5. This will open a window for the user to configure connected IP-enabled Thermal chambers 
6. Assign a Chamber Name that helps you identify it. 
7. If the IP Address is pre-populated on the box beside the temperature controller device IP, 

click on Validate IP to see if the connection is successful. 
 

 
 

8. If no IP has been pre-populated or connection unsuccessful, click on Detect Device. 
9. Follow the Steps mentioned on the dialog box below in the software to find the Serial 

number of the Watlow Device. 
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10. After successfully adding the thermal chamber, you can assign an individual thermal 
chamber to an individual channel. 

11. Save the Startup Configuration and return to the main UHPC Control interface. 
12. From the main UHPC Control channel grid, right click on the channel(s) you wish to have 

associated with the chamber, and then click on Assign Chamber to select the chamber 
name that has been set previously. 
 

 
 

13. The first time a chamber is assigned to a system, the user will be prompted, if they wish to 
display the Connected Chamber Name and Chamber Temperature columns. 



 

62 
 

 
 

14. If “no” was clicked… In the future, if the user wishes to display the thermal chamber 
associated with a channel display grid, click on settings from the top toolbar. 

15. Click on Column Configuration. 
16. Ensure the checkbox next to Connected Chamber Name and Chamber Temperature is set 

to true. 
 

 
 



 

63 
 

Setting Temperature with UHPC Protocol 
 
On the protocol step control list, there is a new step type called Set Temperature. 
 

 
 
Set Temperature Step Type: 
 
A Set Temperature step control type allows for temperature control of NOVONIX IP-Enabled thermal 
chambers. When the set temperature step starts, a command will be sent to the thermal chamber 
temperature controller associated with the running channel. The temperature will be set once, and 
then run until the end step conditions are met. The command will be sent again if the step is 
suspended and resumed. Step control conditions work as with all other protocol steps, but with 
two additional end step conditions, Temperature Variance and Temperature Hold. 
 
By default, for Set Temperature; Temperature Variance and Temperature Hold control conditions are 
used together with an AND condition modifier. Which causes the Set Temperature step to end 
successfully when the temperature is held at the set point within the variance tolerance for the total 
hold time. Temperature Variance and Temperature Hold both use chamber temperature, rather than 
cell temperature when measuring variance. 
 
Note: While it may be tempting to use a super tight temperature variance setting like 0.5C, in 
testing, a hold of about 1C of variance has worked best across the supported temperature ranges. 
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Temperature Control with Multiple Channels 

 
As of UHPC Control version 2.13.0, temperature control for multiple channels has been simplified, 
and synchronization is controlled with a system setting enabled by default labelled Sync Thermal 
Chamber Channels. 
 

 
 
 
When enabled, all channels connected to an IP-Enabled thermal chamber will wait at the ‘Set 
Temperature’ step without executing the temperature change until all running channels assigned ot 
the same thermal chamber are also at the set temperature step. 
 
If channels are out of sync and different temperature set points are being used simultaneously, 
UHPC will choose the majority, and halt the running protocol for the other channels out of sync. 
Step numbers do not need to match, just the temperature set points. 
 
Warning: Assigning different protocols to the same thermal chamber is allowed (with warning 
popup), but if one protocol has no set temperature step for example, all other channels on the 
same thermal chamber could be disrupted from set temperature executing properly. In cases like 
these, where a user wants most channels to stay synchronized in a chamber, and others can run 
freely, consider unassigning the assigned thermal chamber from the channel configuration. This 
can be accomplished by right clicking the channel and clicking Unassign Thermal Chamber. 

Temperature Linking 
 
While not required for thermal chamber / protocol temperature control, Temperatures can be linked 
between channels. So that all selected channels have a temperature that matches one another 
based off one “anchor” channel. This may be useful to some users, under special conditions. 
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This can be accomplished by selecting two or more channels, then right-clicking and selecting Link 
Temperature(s). 

 

  
Figure: The right-click menu showing the Link Temperature(s) option. 

The anchor is the channel that copies its temperature to the other channels. The color display will 
indicate which channel is the anchor. 
 

 
Figure: The temperature assignment menu. 

 
 

 
Figure: Linked temperatures as assigned by the previous box. The anchor channel is the topmost channel. 
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Appendix B – Gamry EIS Integration 
Using Gamry EIS modules connected via USB to the UHPC PC, Electrochemical Impedance 
Spectroscopy (EIS) testing can be conducted at any point during a cell test without any operator 
intervention. Protocols can be created that specify the EIS test conditions. The following sections 
will help: 

Connecting an EIS Device to UHPC Control 

 
Ensure that the Gamry device is connected to the UHPC computer via USB. With UHPC Control launched, 
right click a channel to assign the EIS device to and click “Assign EIS Device”. 

 

 

Figure 58: Assign EIS Device 
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After clicking “Assign EIS Device” a configuration window will appear, allowing the operator to 
select UHPC Channel, Gamry Device, and the corresponding EIS channel. 
 

 

Figure 59: EIS Channel Configuration 

 

 
 
UHPC Channel: The UHPC channel to assign an EIS device to. 
 
Available Gamry Devices: List of all connected Gamry EIS devices. Click refresh to repopulate the 
list. If the connected Gamry device is not appearing in this list, please see the following section: 
Connecting Gamry Hardware and Updating Gamry Firmware 
 
Linked EIS Channel: Many EIS devices are one channel only in which case this value will always 
default to 1, but some devices may contain additional channels to connect multiple cells to the EIS 
device at any given time. This value will identify which Gamry EIS channel is connected to the 
associated UHPC channel. If the list is incorrectly showing 1 channel for a multi-channel EIS 
device, please contact NOVONIX for assistance updating the product support. 
 
Multiple UHPC channels can be configured for Gamry at the same time, but if the same Gamry 
device and channel is selected as an existing channel, the previous channel data will be erased. 
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Figure 60: Overwrite EIS Device Warning 

Connecting Gamry Hardware and Updating Gamry Firmware 

 
After connecting a Gamry EIS device via USB to the UHPC computer, if UHPC cannot detect the 
device some troubleshooting may be required. Typically, this issue is resolved by unplugging the 
Gamry USB cable and/or powering the Gamry device off and back on.  
 
If this is the first time using the Gamry device with UHPC Control, the Gamry device could need its 
firmware updated. Please follow the steps below on updating the Gamry firmware version. 
 
Install and launch Gamry Instruments Framework, which should be provided along with your Gamry 
device, or via the internet, and on the top toolbar click Options -> Instrument Manager. 
 

 

Figure 61: Gamry Instruments Framework 

 
Find the Gamry device on the Instrument Manager device list and run the update. Once the 
firmware is updated to the latest version, and four green checkmarks appear under the device 
status, close the Gamry Instruments Framework and try connecting via UHPC Control again. 
 
If the Gamry device cannot be detected by Gamry Instruments Framework or the Instruments 
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Manager, then please contact Gamry for assistance.  
 

 

Figure 62: Gamry Instruments Manager Update Successful 

 
After connecting the Gamry device to the UHPC Control PC, modified UHPC channel cables can 
connect each Gamry channel to the UHPC chambers. See the image below for an example. 
 

 

Figure 63: UHPC 2A/10A channel cable with Gamry connectors 

 

IMX8 Multiplexer 

 

Some 1-Channel Gamry EIS devices, such as the Interface 1000/1010 or Reference 600+/620, may 
be paired with a Gamry IMX8 Multiplexer. This expands a 1-channel EIS system to 8 channels, 
allowing 8 channels of UHPC Control to pair with EIS on a single device, similar to a 
EISBOX1010/5000.  

https://www.gamry.com/support-2/contact-technical-support/
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Seen below, Configuration for an IMX8 will appear when an IMX8 device has been detected on the 
Assign EIS Device page. An IMX8 may only be paired with a single Gamry device at a time. Removing 
a pairing or changing the paired IMX8 device will impact every channel that uses the paired Gamry 
device. 

 

 
Figure 58:  IMX8 Pairing Selection on Assign EIS Device tab 

 

Viewing EIS Channel Information 
 
Once the channel has had a Gamry device assigned, the assigned EIS device can be viewed by 
updating the Column Configuration. 
To edit the Column Configuration: On the top toolbar of UHPC Control, click Settings -> Column 
Configuration. In the popup window, scroll to the bottom and ensure that “Linked EIS Device” is 
clicked, and press OK, as shown below in Figure . 
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Figure 65 : Updating Column Configuration 

 
Once updated, you should see the EIS device, and associated EIS channel # under the EIS Device 
column in UHPC Control, as shown below in Figure . 
 

 

Figure 66: Assigned EIS Device Channel Information 
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Creating EIS test with UHPC Protocol 
 
On UHPC Protocol there is a new step type called “EIS”. 
 

 

Figure 67: Select Step Type EIS 

 
There are three types of EIS tests that can be run: Galvanostatic, Potentiostatic, and Hybrid.  

 

 

Figure 68: Select EIS Type 

 

Potentiostatic: The most used EIS test, Potentiostatic mode is used when maintaining a constant 
voltage is crucial. This mode is ideal for studying the electrode processes and battery cell behavior 
at a fixed potential, making it useful for analyzing the stability and efficiency of the cell under a 
specific voltage. Researchers often employ this mode to understand the reaction kinetics and to 
identify the resistive and capacitive elements within the cell. 

You wouldn't want to run a test in Potentiostatic mode if the impedance of the cell is very high (small 
cell), as this could result in unstable voltage control and inaccurate measurements. 
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Galvanostatic: Galvanostatic mode is employed when a constant current is required during EIS 
testing. This mode is particularly useful for examining the response of a battery cell to steady current 
flow, which is representative of real-world operating conditions. It allows for the study of charge 
transfer resistance and mass transport processes, making it valuable for understanding the 
performance and limitations of the battery under consistent load. 

Avoid using galvanostatic mode if the cell has very low impedance (large cell), as maintaining a 
constant current can lead to excessively high or low voltages that may damage the cell or distort the 
data. 

 

Hybrid: Hybrid mode combines the features of both Potentiostatic and galvanostatic modes, 
allowing for more versatile and comprehensive EIS testing. This mode can adapt to changing 
conditions by switching between maintaining a constant voltage or current as needed. It is beneficial 
for dynamic studies where the battery cell's behavior under varying loads and potentials needs to be 
analyzed, providing a more complete understanding of the cell's electrochemical characteristics. 

Hybrid mode may not be ideal if the system's response is highly non-linear, as the switching between 
voltage and current control could introduce artifacts or complicate the interpretation of the 
impedance data. 

 
 
Each type of EIS can be configured from the default values using the “Configure” button. Each 
configure page is similar to the Gamry Instruments Framework configuration for the corresponding 
EIS type. 
 
Running an invalid Gamry EIS protocol may impact testing, at this time UHPC may not validate an 
EIS protocol to the same extent as Gamry Instruments Framework. When setting up a configuration 
for the first time, we recommend testing the configuration with Gamry Instruments Framework to 
ensure that the settings are valid and that the EIS test completes successfully. Improper settings 
may result in test failures. 
 
It may be valuable to obtain a full impedance spectrum of a cell via the Gamry Instruments 
Framework before running an integrated UHPC and EIS test. This will help estimate impedance 
values and confirm the EIS data collected via UHPC Control. 
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Figure 69: Galvanostatic Configuration Window 

 

The end conditions and data save conditions for EIS are optional. Channel information values may 
be recorded by UHPC while running EIS on a cell, but current will always be recorded as 0A. The 
current sense is disabled for the length of an EIS test for safety reasons, but voltage can be 
recorded. 
 
Ending an EIS step too early with end conditions may result in an incomplete EIS test file. If using a 
multi-channel EIS device, concurrent EIS tests may be queued for some Gamry device types, so in 
some cases, an EIS step may take longer than expected. 

 

Running EIS Test with UHPC Control 

 
After assigning an EIS device to a UHPC channel, and creating a protocol containing EIS in UHPC 
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Protocol, all that’s required to run a cell test with EIS is starting the test like any other protocol. 
Simply start the test and wait for it to execute.  
 
Referring to Figure , you can see three steps are in EIS, all on the same EIS device. Only one EIS test 
can execute at a time per EIS device, because Gamry EIS multi-channel devices are multiplexed. 
This results in the occasional “EIS Step in Queue” Active Step Display. 
 
Validation occurs while assigning a protocol, so an error will be thrown if no EIS device has been 
detected when assigning a protocol containing EIS as seen in Figure . Similarly, if the assigned EIS 
device cannot communicate with UHPC, an error will appear in the “Error Log” at the bottom of the 
UHPC Control screen, as seen in Figure . If connection with the Gamry EIS device is lost 
before/during a test, and the system will attempt to reconnect in the background. The UHPC test 
will not be impacted until the EIS step is reached. The test will halt in error if the EIS device cannot 
communicate while executing the EIS step. 
 

 

 

Figure 70: Missing EIS Device Error Window 

 

 

 

Figure 71: Cannot Communicate with EIS Error Log 

 

Safety Warnings 

 
Do not use Gamry Instruments Framework to run an EIS test or any diagnostics while 
conducting a test with UHPC Control on the same integrated UHPC/Gamry channel cable, this 
could result in damage to the UHPC or Gamry hardware. As a safety precaution, if the Gamry unit 
is connected properly with UHPC Control running, the software will prevent that Gamry unit from 
being used by Gamry Instruments Framework. 
 
For safety guidelines specific to Gamry devices, please refer to the Operator’s Manual provided with 
your Gamry equipment. 
 
Current ranges on UHPC hardware and Gamry hardware may vary, and EIS tests designed for large 
cells may contain currents that are damaging to small cells. Always double check that the cell 
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matches the protocol and consider the expected current or voltage response before running a test. 
 

Viewing EIS Data 
 
After running an EIS test, the EIS data will be saved to a folder located with the UHPC test data. The 
folder name will be labelled “datafileName_EIS”. Inside of the folder, each EIS test ran for that test 
will be labelled “datafilename_step-##_cycle-##.dta”. These files will be used like any other Gamry 
.dta file, using Gamry Echem Analyst, or opened by Gamry Instruments Framework->Analysis-> 
Start Analysis. 
 
Please see Figure  below for an example of viewing EIS data in Gamry Echem Analyst. At this time 
UHPC Plot does not open Gamry EIS .dta data files. 
 

 
Figure 72: View EIS Data 

Why EIS Testing with UHPC? 
 
Electrochemical impedance spectroscopy (EIS) delivers results that are complementary to 
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conventional cycle testing. Specifically, EIS measurements reveal kinetic information about 
individual parts and processes within a cell. When combined with UHPC experiments, a full suite of 
parameters such as the coulombic efficiency, charge endpoint capacity slippage, and resistances 
associated with electronic contact, ionic charge transfer and diffusion can be obtained, used to 
develop a deep understanding cell performance and iterate rapid improvements. 
  
The pairing of a Gamry EIS device with a NOVONIX UHPC system also eliminates challenges often 
associated with combined cycling and EIS experiments. These include the labor required to 
conduct testing on separate machines, managing different temperatures for EIS and cycling 
experiments, and the complexity of acquiring EIS data at multiple states-of-charge 

Appendix C – API Remote UHPC Control Interface 
When API Communications is enabled in UHPC Control, a local socket server runs, listening for 
connections on a user-configured IP address and port. The server accepts valid messages to 
command UHPC Control to start, stop, suspend, resume tests, update details, and fetch channel 
status. 
 
The following sections outline message formats, various commands, and examples. 
 

API Configuration 

 
In the UHPC Control toolbar, navigate to Settings > System Configuration > Features to find the 
'Enable API Communications' option. Checking this box will start a socket server using the IP and 
port set in the API Configurations page. 
 

 
Figure 73: Enable API Communications 

 
The API Communications Configuration page (Figure ) is accessed by clicking the Configure button 
next to the "Enable API Communications" checkbox in the Features tab.  
 
By default, the IP Address is set to 0.0.0.0. Allowing communications to the UHPC Control 
workstation from any connected network that permits traffic through port 11000. Alternatively, 
users can assign a specific IP for access over a particular network. In both cases, the user must 
know the workstations network IP. This can be obtained via the IT department, or by running 
“ipconfig” in the Windows command prompt. 
 
The remaining options are a subset of the notification settings found in the Notifications tab of the 
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UHPC Control System Configuration. When sending an API command, popups for actions like 
setting channel information or starting a test must be allowed or denied. If an action type is set to 
error, both the channel action and the API request response will result in failure. 
 
Clicking any of the [ ? ] icons next to a configuration option will display detailed information about 
that setting in the textbox at the bottom of the page. 

 
Figure 74 : Configure API Communications 

 

UHPC Control API Message Format 
 
The API Message Format uses the JSON RPC 2.0 standard for all requests and responses. More 
detailed information can be found at https://www.jsonrpc.org/specification.  
 
All requests to UHPC Control via the API will follow the format outlined in Table 1: External UHPC 
Request, with Parameters specified in Table 2: UHPC Channel Reques or Table 3: UHPC Channel 

https://www.jsonrpc.org/specification
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Update Request. 
 
Responses from UHPC Control will confirm to the format described in Table 4: External UHPC 
Success Response or Table 5: External UHPC Error Response. The success response may 
contain a result with a list of objects defined in Table 7: UHPC Channel Status, while the error 
response may contain an error object outlined in Table 6: JsonRpcError. 
 
The following sections will provide samples of each message type with descriptions of their 
functionality. 
 

Name Type Description 

jsonrpc string A String specifying the version of the JSON-RPC protocol. 
Must be exactly "2.0" 

method string 

A String containing the name of the method to be 
invoked: 

getStatus, setChannelInfo, startChannel, stopChannel, 
suspendChannel, resumeChannel 

id String or int 
An identifier established by the Client that must contain 
a String or Number. This isn’t required to be unique 
between requests but helps differentiate the response. 

params 

UHPC Channel 
Request  
or  
UHPC Channel 
Update Request 

JSON in the form of an object, containing the information 
server needs to handle request 

Table 1: External UHPC Request 

 
 

Name  Type  Description  
channels  int[]  An integer array containing channel numbers. This array 

must not be empty, and must have valid channel number  

Table 2: UHPC Channel Request 

 

Name  Type  Description  
channelNum 
(required) 

int  Channel Number for request to update. 

mass  string  Mass for channel.  
capacity  string  Cell capacity for channel.  
description string  Description for the channel to be saved into the datafile 

and displayed in cell grid.  
dataFilePath  string  Absolute path for datafile to be saved.  

Note: Must use / not \  
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protocolPath  string  Absolute path to find protocol file.  
Note: Must use / not \  

ipAddress (optional) string Used to differentiate between master controllers when 
using Multi-System mode. 

Table 3: UHPC Channel Update Request 

 
 
 

Name  Type  Description  
jsonrpc  string  A string specifying the version of the JSON-RPC protocol. 

Must be exactly “2.0”.  
result  string  

or  
UHPC Channel 
Status [ ]  

A string containing the word “SUCCESS”  
or an array of UHPC Channel Status objects.  

id  string  The ID provided in the request.  

Table 4: External UHPC Success Response 

 
 
 

Name  Type  Description  
jsonrpc  string  A String specifying the version of the JSON-RPC protocol. 

Must be exactly "2.0".  
error  JsonRpcError  Object containing the error details. 
id  string or int  An identifier established by the Client that must contain a 

string, or number.  

Table 5: External UHPC Error Response 

 
 
 
 
 
 
 

Name  Type  Description  
code  int  Error codes: 

-32700: Parse error (Invalid JSON was received by the 
server, an error occurred on the server while parsing the 
JSON text). -32600: Invalid Request (JSON sent is not a 
valid Request object).  
-32601 Method not found (The method does not exist or is 
not available).  
-32602 Invalid params Invalid method parameter(s).  

message  string  A string providing a short description of the error. The 
message should be limited to a concise single sentence.  
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data  string[]  A string array containing a detailed list of errors.  

Table 6: JsonRpcError 

 
 
 

Name  Type  Description  
channelNumber  int  Channel Number.  
status  string  Status of channel: Idle, Running, 

Completed, Suspended, Disabled, 
InError  

mass  string  Mass set for channel.  
cap  string  Cell capacity set for channel in 

AmpHours. 
description  string  Description for the channel.  
currentProtocolStepNumber  int  Current step number of protocol.  
dataFilePath  string  Absolute path to the datafile.  
protocolPath  string  Absolute path to the protocol file. 
activeStepDisplay  string  String representing the current step being 

executed.  
temp  string  Reported temperature of the cell.  
runTime  string  Total run time of protocol in hours.  
stepTime  string  Total run time of the active step in hours.  
current  string  Current being applied to cell in Amps.  
potential  string  Potential of cell in Volts.  
cycleNum  string  Current cycle the protocol is on. 

Table 7: UHPC Channel Status 

Get Channel Status 

 
The “Get Channel Status” format is an External UHPC Request that includes a list of channel 
numbers for parameters. It will return the channel information for the requested channels with a list 
of UHPC Channel Status objects described above. 
 
Examples: 
 
{"jsonrpc": "2.0", "method": "getStatus", "id": "1", "params": {"channels":[3]}} 
{"jsonrpc": "2.0", "method": "getStatus", "id": " ffa044c5-00de-4fce-90d7-ae5060a978f7", "params": 
{"channels":[1,10]}} 
 
Example Response: 
 
{{ 
  "jsonrpc": "2.0", 
  "id": "ffa044c5-00de-4fce-90d7-ae5060a978f7", 
  "result": [ 
    { 
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      “channelNumber": "01", 
      "description": "API Description set", 
      "status": "Running", 
      "dataFilePath": "C:\\Users\\uhpc-dev.svc\\Desktop\\UHPC\\Protocols\\results\\2024-10-
08_TC52_Run1_C1_CH01.csv", 
      "protocolPath": " C:\\Users\\uhpc-dev.svc\\Desktop\\UHPC\\Protocols\\TC52_API.pro2", 
      "currentProtocolStepNumber": 1, 
      "activeStepDisplay": "Open Circuit Storage", 
      "temp": "22.208?C", 
      "runTime": "52.88 s", 
      "stepTime": "52.88 s", 
      "current": "0.00000000 A", 
      "potential": "1.57916114 V", 
      "cycleNum": "1/1", 
      "mass": "2.0", 
      "capacity": "2.0" 
    }, 
    { 
      "channelNumber": “10", 
      "description": "Enter description here...", 
      "status": "Idle", 
      "dataFilePath": "", 
      "protocolPath": "Click to select protocol file...", 
      "currentProtocolStepNumber": 0, 
      "activeStepDisplay": "---", 
      "temp": "22.182?C", 
      "runTime": "---", 
      "stepTime": "---", 
      "current": "---", 
      "potential": "3.62160253 V", 
      "cycleNum": "---", 
      "mass": "1.000", 
      "capacity": "1.000" 
    } 
  ] 
}} 
 

Set Channel Info 

 
The “Set Channel Info” format is an External UHPC Request that includes a list of UHPC Channel 
Update Requests for parameters. After setting the channel info, in the case of success, a simple 
UHPC Success Response will be returned. 
 
Examples: 
 
{"jsonrpc": "2.0", 
  "method": "setChannelInfo", 
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  "id": "1b", 
  "params": [{ 
      "channelNum": 1, 
      "mass": "2.2", 
      "capacity": "1.5", 
      "description": "channel1description", 
      "dataFilePath": "C:/Novonix/TestResults/2024-09-21_TC01_R1.csv", 
      "protocolPath": "C:/Novonix/ProtocolFiles/TC01_DeltaI_CC_ChargeConditionUnits.pro2" 
    }, 
    { 
      "channelNum": 3, 
      "dataFilePath": "C:/Novonix/TestResults/2024-09-21_TC02_R1.csv", 
      "protocolPath": "C:/Novonix/ProtocolFiles/TC02_DeltaI_CC_DischargeConditionUnits.pro2" 
    }]} 
 

Start Channel 

 
The “Start Channel” format is an External UHPC Request that includes a list of UHPC channel 
numbers for parameters. After starting the channels, in the case of success, a simple UHPC 
Success Response will be returned. If any channel fails to start, a UHPC Error Response will be 
returned. 
 
Examples: 
 

{"jsonrpc": "2.0", "method": "startChannel", "id": "54", "params": {"channels":[1]}} 

{"jsonrpc": "2.0", "method": "startChannel", "id": "55", "params": {"channels":[1,2,3]}} 

 

Stop Channel 
 
The “Stop Channel” format is an External UHPC Request that includes a list of channel numbers for 
parameters. After stopping the channels, in the case of success, a simple UHPC Success Response 
will be returned. If any channel fails to stop, a UHPC Error Response will be returned. 
 
Examples: 

{"jsonrpc": "2.0", "method": "stopChannel", "id": "23", "params": {"channels":[2]}} 

{"jsonrpc": "2.0", "method": "stopChannel", "id": "24", "params": {"channels":[1,2,3,4]}} 
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Suspend Channel 
 
The “Suspend Channel” format is an External UHPC Request that includes a list of channel 
numbers for parameters. After suspending the channels, in the case of success, a simple UHPC 
Success Response will be returned. If any channel fails to suspend, a UHPC Error Response will be 
returned. 
 
Examples: 

{"jsonrpc": "2.0", "method": "suspendChannel", "id": "twelve", "params": {"channels":[8]}} 

{"jsonrpc": "2.0", "method": "suspendChannel", "id": "thirteen", "params": {"channels":[1,2,3]}} 

Resume Channel 
 
The “Resume Channel” format is an External UHPC Request that includes a list of channel numbers 
for parameters. After resuming the channels, in the case of success, a simple UHPC Success 
Response will be returned. If any channel fails to resume, a UHPC Error Response will be returned. 
 
Examples: 

{"jsonrpc": "2.0", "method": "resumeChannel", "id": "1a", "params": {"channels":[3]}} 

{"jsonrpc": "2.0", "method": "resumeChannel", "id": "1b", "params": {"channels":[2,3]}} 

 

Clear Channel Info 
The “Clear Channel Info” format is an External UHPC Request that includes a list of channel 
numbers for parameters. After clearing the channels, in the case of success, a simple UHPC 
Success Response will be returned. If any channel fails to clear, a UHPC Error Response will be 
returned. 
 
Examples: 

{"jsonrpc": "2.0", "method": "clearChannelInfo", "id": "1a", "params": {"channels":[3]}} 

{"jsonrpc": "2.0", "method": "clearChannelInfo", "id": "1b", "params": {"channels":[2,3]}} 

 

Sample Message Responses 

 

The SUCCESS response for all message types is identical, as shown below. Note that getStatus is 
the exception, which is described in the Get Channel Status section above. 
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Additionally, below are a few sample error messages that may be returned: 
 
Examples: 
 
{ 
  "jsonrpc": "2.0", 
  "result": "SUCCESS", 
  "id": "request_1" 
} 
 
{ 
  "jsonrpc": "2.0", 
  "error": { 
    "code": -32602, 
    "message": "System: Sys1, Channel: 2: Channel 2: [Global Limit] Constant Current Charge Step 2 
condition when voltage > 14.2 V ", 
    "data": null 
  }, 
  "id": "request_2" 
} 
 
{ 
  "jsonrpc": "2.0", 
  "error": { 
    "code": -32602, 
    "message": "System: Sys1, Channel: 3, Cannot stop an idle channel.", 
    "data": null 
  }, 
  "id": “request_3" 
} 
 
{ 
  "jsonrpc": "2.0", 
  "error": { 
    "code": -32602, 
    "message": "System: Sys1, Channel: 5, Cannot resume a idle channel.", 
    "data": null 
  }, 
  "id": "request_4" 
} 
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Contact Us 
 

 

NOVONIX Battery Technology Solutions 

110 Simmonds Drive 

Dartmouth, NS B3B 1N9 

BTS-Support@novonixgroup.com 

+1 (782) 888-0528 
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